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Introduction

Welcome to the world of digital audio! Your new SoundMeister™ card
opens up your Apple IIgs to whole new world in multimedia education,
entertainment and excitement! You will soon be able to play rich,
vibrant, colorful sounds and music as well as record your own audible
creations. You will add sounds to your HyperStudio or HyperCard Ilgs
stacks and play them back with high fidelity. You will liven up your
computing experience by creating fun system sounds and playing them
back during specific events such as disk inserts/ejects. Additionally, any
application that generates sounds using the Apple IIgs’ built in Digital
Oscillator Chip (DOC) will now be able to do so in stereo. The Apple
Iigs has better built in sound generation capability than any other
personal computer and you will soon hear why!

What is the SoundMeister?

The SoundMeister is an expansion card that plugs into one of the seven
expansion slots located inside your Apple Ilgs case. It takes the audio
signal produced by the IIgs DOC and splits it up into two distinct
channels providing a stereo output. The SoundMeister then amplifies
these signals so you can hear the sound on a pair of regular speakers. For
louder volume levels, the SoundMeister also provides a standard audio
signal so you can can plug it into the back of your home stereo equip-
ment. Lastly, the SoundMeister provides the ability to record an audio
source. Unlike other cards produced in the past, this source can be either
a regular microphone or the output from your home stereo equipment!

What You Should Have Received

Before we get started, make sure that you received everything you were
supposed to. The SoundMeister package should include: SoundMeister
interface card, 7-Pin sound expansion cable, a disk labeled
‘DigitalSession’ and this manual.
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Installation

Installation of the SoundMeister is fairly simple and straightforward. It
requires no tools other than a Philips head screwdriver, and can be
performed in less than half an hour. It does, however, require opening
your computer’s case and possibly removing and replacing other expan-
sion cards that may already be installed. If you are at all uneasy or
unsure about performing this operation then we suggest taking your
SoundMeister and Apple IIgs CPU to your nearest computer dealer and
have them perform the installation for you. Better yet, contact your local
Apple II user group for assistance. You will be most likely to find an
enthusiastic member who would love to help you install your
SoundMeister card. For the name and address of your nearest Apple I
user group call the Apple User Group Connection at 1-800-538-9696 ext.
500. Be sure to indicate that you are looking for an APPLE II user
group!

Prepare Your Work Area

To access your Apple IIgs expansion slots you will have to remove your
monitor and any other external peripherals that may be in the way. We
suggest disconnecting all cables from the back of your CPU and moving
it to a work bench or table away from your computer desk. This gives
you complete access to all angles of your Apple IIgs CPU.

Open The CPU Case

Depress the two plastic tabs at
the rear of the CPU case while
lifting up on the lid. This is
best done by reaching around
the back of the case, depress-
ing each tab simultaneously
with your index fingers while
pushing up on the lid with the
palms of your hands.

Removing The CPU Lid
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Discharge Yourself Of Any Static Charge

With the Apple Ilgs case open, locate the power supply. This is the large
rectangular, metallic box at the left side of the computer. Touch your
hand to the power supply (Note that while this method is considered safe,
it is actually better to touch a metallic object that comes in contact with
the floor such as a table or chair leg...).

| Inside the llgs
Panel Holes
Slots

Power Supply

Memory Expan-
sion Connector

Sound Expan-
sion Connector

Locate The Expansion Slots

The expansion slots are arranged in a row of seven, towards the rear of
your computer’s logic board. Chances are, if you have a hard drive or
other such peripheral, you already have a card in one of these slots. The
slots are numbered from left to right, one through seven. Thus slot one is
closest to your power supply while slot seven is furthest away. You may
also notice a single ‘slot’ by itself toward the front right of the logic
board. You may or may not have a card already plugged into this slot.
This is your memory expansion connector and isn’t really considered a
slot.

The SoundMeister will be installed in one of the seven expansion slots.
Exactly which slot is entirely up to you... you can place it in any one
except slot number three. Most people will want to use either slot one or
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slot two for their SoundMeister cards. Pick one of these slots unless you
have another card already installed in them.

Install The Sound Expansion Cable

The sound expansion cable plugs
into your Apple IIgs logic board
at the sound expansion connector.
The sound expansion connector is
located just in front of the
memory expansion slot. If you
have a memory expansion card,
you will want to remove it to
allow easy access to the sound
expansion connector.

Take the sound expansion cable Sound Expansion Cable
provided with your SoundMeister

and locate the end which has a connector with a single row of seven
holes. This connector plugs into the sound expansion connector on the
logic board. There is only one way to comfortably plug the connectors
together. Take extra care to make sure that all seven pins on the sound
expansion connector align with the seven holes on the sound expansion
cable. When plugged in, the sound expansion cable should naturally fall
towards the power supply. You want this cable to run underneath the
front of any other cards you may have installed in your computer.

At this point, if you removed the memory expansion card, plug it back
into the memory expansion slot.

Remove A Panel Cover

At the back of the CPU case, near the slots, you’ll notice several panel
holes that are covered by plastic plates. These plates are designed to be
removed by twisting the metal clips on the inside of your case counter-
clockwise. There are three different size panel holes/plates. The
SoundMeister input/output plate will be mounting in one of the largest
panel holes. Exactly which panel hole is up to you but is largely deter-
mined by two factors: 1) it has to be a panel hole to the right of whatever
slot your SoundMeister will be going in (a good reason NOT to choose
slot seven for your SoundMeister card!), and 2) other expansion cards
may be making use of some of these holes thus narrowing down your



SoundMeister Stereo/Digitizer Card 7

choices.

When you decide which panel hole to use, remove its cover by rotating
the metal clip counter-clockwise.

Install The Sound Input/Output Plate

The Input/Output connectors are mounted on a metal plate which is
attached to your SoundMeister card by three shielded wires. This metal
plate has a top and a bottom. The top of the plate has two 3.5mm mini-
phone jacks grouped together, while the bottom has one 3.5mm mini-jack
by itself. There are also two Philips-head screws on the metal plate.
Remove the ‘top’ screw completely while unscrewing the bottom one
approximately half-way. Position the metal plate inside the panel hole
you just uncovered. Notice that there are two notches at the top and
bottom of the panel hole to accommodate the mounting screws. Slide the
half-removed screw into the bottom notch. Follow this by replacing the
screw you removed through the back of the panel hole. Ti ghten up on
both of these screws so that the metal plate is solidly mounted.

Install The SoundMeister Card

Insert the SoundMeister card into the slot you have chosen. Be careful to
route the SoundMeister’s three input/output audio cables around the back
of any other cards that may be in the way. Do not route them over the
top of any other card since the computer’s lid does not provide the extra
room to do so. You may want to consider removing any other cards that
are in the way until you’ve installed the SoundMeister card.

When inserting the card, angle the back of the SoundMeister’s edge
connector towards the rear of the slot then push down towards the front
of the card. Seating the card completely in the slot may require a bit of
force. Be careful not to bend any of the components mounted on the
SoundMeister card itself. When seated completely, you should just
barely be able to see the top of the SoundMeister’s gold plated edge
connector.

Connect The Sound Expansion Cable
Fasten the end of the sound expansion cable with the double row connec-

tor to the 14-Pin header on the top front of the SoundMeister card. To do
this requires coming ‘up-and-over’ the back of the card. When mating
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the connector make sure that all of the pins are aligned correctly with the
holes on the cable’s connector. When installed, there should be no kinks
or twists in the sound expansion cable. If the cable twists, then it is
plugged in wrong!

F e

5

SoundMeister Card - Completely Installed

Replace All Expansion Cards

If you removed any other cards during the installation process, replace
them in their correct slots at this time. Make sure all cards are firmly
seated, even if you did not remove them. When installing a new card in
your Apple IIgs it is quite easy to accidentally loosen a previously
installed card.

Replace The Lid

Replacing the Apple IIgs lid is the reverse of removing it. The lid pivots
on the plastic ‘fingers’ at the front of the case. Lower the back of the lid
until it meets friction with the two plastic tabs at the rear, then press
firmly but gently until it snaps closed.
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Your SoundMeister Card Is Now Installed!

Whew! That wasn’t so bad was it? It is now time to reassemble your
computer, plugging all of those external peripherals back into it. But
wait, we forgot one thing! What are we going to connect the
SoundMeister to? Without speakers or a microphone the SoundMeister
is pretty useless. The following section explores the several options
available to you.

Understanding The Input/Output Connector

Before we go on, it helps to know what those three new mini-phone
plugs on the back of your computer are all about. But first, let us define
the three types of audio signals that the SoundMeister deals with:

High Level- This refers to an amplified, high power signal, usually used
to drive a pair of speakers. Those ‘zip’ cords that you run from your
home stereo equipment to your speaker cabinets are carrying a high-level
signal.

Line Level- Refers to an intermediate, relatively weak signal that
happens to be the standard method for carrying an audio signal between
audio equipment. When you connect a CD player to your home stereo
receiver, you are connecting a line level signal between the two devices.

Mic Level- Refers to a very weak signal, typically generated by micro-
phones. This signal is very week because a microphone induces an
electric current based on the vibration of sound waves and there is only
so much electric current that a sound wave can generate.

If you haven’t guessed already, the three new plugs on the back of your
computer each deal with high, line and mic level signals. The plugs
themselves are refered to as mini-phone jacks and measure 1/8" (3.5mm)
in diameter. They are stereo phone jacks which means each jack carries
two distinct channels of audio.

The SoundMeister has two output jacks meaning these jacks carry signals
that produce sounds. The two outputs are the two jacks grouped together
on the top side of the panel plate. The topmost jack is the ‘high-level’
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output. Tt carries an amplified signal that is intended to be connected
directly to speakers. The middle jack is the ‘line-level’ output. It is
intended to be connected to external equipment for further amplification.

software that runs on the IIgs.

@ The SoundMeister has one jack that can
be used as an input meaning the audio
@.___ High-Level signal fed to this jack can be digitized
Output (converted to digital data) by the Apple
Hgs and played back later. The bottom
@“'--. Line-Level jack on the panel plate is the input jack.
Output This one jack serves a dual role as it can
take both line-level and mic-level
Mic/Line signals as inputs. Exactly which type of
@ Input signal is being used can be controlled by

Connecting Specific Devices

Now that you know what each phone jack is for, it is time to consider
what devices to connect to your SoundMeister and how each device
should be connected. This section discusses the most common configu-
ration options available to you. It is by no means the final word since the
combination of different types of stereo equipment is quite vast.

Connecting Unpowered Speakers

The term ‘unpowered speakers’ refers to standard, plain audio loudspeak-
ers, the type you connect to your home stereo equipment. The qualifica-
tion ‘unpowered’ is used because, in the past, sound cards for the IIgs
required that you used speakers that had built in amplification. This is
not the case with the SoundMeister thus offering a much more economi-
cal alternative.

There are two basic cabling schemes that may be used to do this. The
first requires purchasing a (or build your own) cable that converts a
3.5mm mini-phone plug to two separate speaker ‘zip’cords. One cord
would then connect to your left speaker, the other to your right.

The alternative method requires purchasing a 3.5mm mini plug to two
female RCA “Y™ adaptor. You can then use readily available speaker
wire with a male RCA plug on one end for each channel. This is the
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more expensive option but it gives you a “Y” adaptor that can be used for
other purposes.

In both cases, the 3.5mm mini-phone plug will plug into the top jack on
the SoundMeister panel plate.

Unpowered Speakers using Unpowered Speakers using
custom 3.5mm phone cable. mini-phone to RCA "Y" adaptor.

Connecting Amplified Speakers

Amplified speakers are just regular speakers with a built in power
amplifier to provide high volumes. These type of speakers are typically
high priced and lower sound quality than unpowered speakers. To get
really good sounding amplified speakers be prepared to spend over $100
for a pair! This is not the option recommended by ECON Technologies!
You can get equal or better quality from unpowered speakers at a
considerable savings. A good pair of mini-speakers (unpowered) can be
purchased for $30-$40 from a wide variety of outlets. Furthermore, the
SoundMeister provides software volume control but only on the ampli-
fied (high-level) output. Thus if you connect a pair of amplified speakers
with no built in volume control, you will be forced to listen to full
volume output at all times! This can be quite annoying!

Just how a pair of amplified speakers is connected to your SoundMeister
depends largely on the type of cabling the speaker uses. Most good
quality amplified speakers will use RCA type patch cords. If this is the
case then you will need to purchase a 3.5mm mini plug to two female
RCA jack “Y” adaptor. You will then plug the speaker’s RCA cables
into the “Y” adaptor. I
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Some amplified speakers will
have a 3.5mm mini-phone
jack on its cable. This is the
type of speaker that typically
plugs into ‘WalkMan’ type
equipment. To connect this
type of speaker into your
SoundMeister, a 3.5mm
stereo-to-mono *Y” adaptor
will be needed.

In almost all cases, plugging
an amplified pair of speakers
into your SoundMeister
requires using the middle
(line-level) mini-phone jack
on the panel plate. This is very important since plugging into the top,
high-level phone jack could damage your speakers and/or SoundMeister.
There are, however, some high quality amplified speakers that allow you
to flip a switch to determine if the sound source is amplified or not. If
this is your case then we suggest you set this switch to indicate an
amplified source and then plug into the top (high-level) phone jack on the
SoundMeister panel plate. This will give you much better results.

Powered Speakers using
mini-phone to RCA "Y" adaptor.

Connecting External Stereo Equipment

For the highest fidelity output with your SoundMeister card we recom-
mend connecting to an external amplifier such as a home stereo receiver.
Home stereo equipment gives you complete attenuation (volume control)
and tone control so you can match your sound output to your personal
preferences. The SoundMeister purposely has both a line-level and high-
level output so that, during normal computer usage, you can rely on an
inexpensive pair of unpowered speakers but when you want to really
‘crank’, then you can reach over and turn on your stereo equipment.

The most common arrangement is to use a 3.5mm mini-phone to female
RCA adaptor, then use standard patch cords to connect to your stereo
equipment. You can connect to any one of the input source plugs except
‘phono’ which is intended for turntables (remember those?). In most
cases you would want to connect to your ‘tape’ input. The tape loop on
the back of your stereo equipment has a two pairs of plugs, one marked

‘Play’, the other marked ‘Record’. You will want to plug into the pair
marked ‘Play’.



SoundMeister Stereo/Digitizer Card 13
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®

To Stereo Receiver ->
Plug into 'PLAY" on the
-@~ record loop.

Connecting the SoundMeister to external stereo equipment
using a RCA "Y" adapter and patch cords..

In all cases, you will plug the 3.5mm mini-phone plug into the middle
(line-level) jack of the SoundMeister panel plate. Never plug stereo
equipment into the SoundMeister high-level output!

Recording An Audio Source

Now that we have taken care of sound output, lets not forget about audio
input. You will undoubtedly want to make recordings with your
SoundMeister card and this is how you will most likely do it...

Connecting A Microphone

Most inexpensive microphones will already have a 3.5mm mini-phone
plug on the end of their cable. If this is your case, simply plug it into the
bottom phone jack of the
SoundMeister panel plate.
You must then make sure
your digitizing software is
configured to make a ‘mic-
level’ recording and you’ll be
set to go.

Higher quality microphones’
*will have a 1/4" phone plug
on the end of their cable. To
get one of these microphones
to work a simple 1/4" to 1/8"
(3.5mm) adaptor is all that is
necessary.

Connecting a microphone to the
SoundMeister using a 3.5mm plug.
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Recording From Stereo Equipment

The SoundMeister has the unique ability to record from line-level
sources such as your home stereo equipment. This will give the truest,
highest quality recordings since the audio signal is much stronger and
cleaner than that of a microphone.

To record from your home stereo equipment requires that you tap into the
‘tape loop’ of your stereo equipment. Virtually all stereo receivers
provide such a tape loop so that whatever you are listening to can be
recorded by a tape-deck. This also allows your radio, CD-player,
turntable, etc. to be recorded by your SoundMeister!

To Stereo Receiver ->
Plug into 'RECORD' on the
record loop.

® ®®

@@
;

Connecting the SoundMeister to record fromexternal stereo
equipment using a RCA "Y" adapter and patch cords..

To plug into your stereo equipment’s tape loop requires a 3.5mm to
female RCA “Y” adaptor. This adaptor will be plugged into the bottom
phone jack on the SoundMeister panel plate. You can then use standard
RCA patch cords to connect to the tape loop on your stereo equipment.
The tape loop on the back of your stereo equipment has two pairs of
plugs, one marked ‘Play’, the other marked ‘Record’. You will want to
plug into the pair marked ‘Record’. If by chance you already have a tape
deck on your stereo system, use a RCA female to RCA male “T” adaptor
to allow both the tape deck and SoundMeister to be plugged into the
‘Record’ plugs.

To make recordings be sure your digitizing software is setup to record
from a line-level source. Be sure to do this since setting the source to
‘mic’ level but connecting ‘line’ level will overload the input on your
SoundMeister.
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If you will be switching between ‘line’ and ‘mic’ level inputs frequently
we strongly suggest you purchase an audio mixer. Inexpensive varieties
are readily available from your local Radio Shack store. A mixer will not
only allow both inputs to be simultaneously connected, but will give you
total control over the input level. Thus you could record your voice over
the output from your CD-player!

Installing The Software

The SoundMeister hardware is now ready to be used. For sound output,
you will need to do nothing special... any application that generates
sounds will now do so through the SoundMeister. As for making
recordings, virtually any application that can record sound data will work
with the SoundMeister hardware. Other than these obvious requirements,
you will not need any special software to take advantage of the
SoundMeister. However, for enhanced use of the SoundMeister board,
we’ve provided some special software that allows you to control the
amplified output volume and whether or not the input source is ‘Line’ or
‘Mic’ level. This software is implemented as an INIT/Control Panel
combination so that you can make these changes from within any desktop
based application. You must be running GSOS System 6.0 to use the
software provided with the SoundMeister card. If you are not running
System 6.0 you can obtain a copy by contacting your favorite Apple II
dealer or your local user group.

In addition to the INIT/Control Panel, we’ve also included an application
program called DigitalSession™. This application is useful for recording
your own sounds and/or editing existing sound files you may have. It
can apply filters and special effects to any sound file you load. When
finished, you can save your sounds in a variety of useful formats so that
other applications such as HyperCard IIgs and HyperStudio can take
advantage of them. DigitalSession is discussed later in this manual.

Using The Custom Installer

To install the INIT/Control Panel combination or DigitalSession, you
should boot your Apple IIgs into the Finder™. Insert the disk labelled
‘DigitalSession’ in the 3.5" disk drive. A window should open on the
desktop with a couple of icons in it. Double-click the icon named
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‘Install’. This launches the custom installer program we provide for you.

When the installer first comes up it will ask you to enter your name and
the name of the organization you belong to (if any). This registers you as
the legal owner of this software. Enter the appropriate information and
click the ‘Continue’ button.

After a few moments, another window will appear. In this window there
are two check boxes labelled ‘Install INIT/Control Panel’ and ‘Install
Digital Session’. By default they should both be checked. If you only
want to install one or the other, then you should uncheck the item you do
not want installed.

To select the destination volume, you can continually click the ‘Next
Disk’ button. This will show the next online volume at the top of the
window as your destination disk. By default, the installer shows your
boot volume as the destination disk. This is because the INIT/Control
Panel must be installed on a bootable volume. The application
‘DigitalSession’ may be placed on any volume. It will be copied into a
folder named DigitalSession on whatever disk you choose. Once
installed, it can be copied virtually anywhere, provided you copy all of its
accompanying files.

When you have chosen your destination disk, and are ready to perform
the installation, click the ‘Install’ button. The appropriate files will then
be copied to where they belong. When finished, you will be informed of
the installer’s success or failure by an alert dialog. Note that you can
repeatedly install the software onto several disks while this window is
open.

When you are finished installing the software, click the ‘Done’ button. If
you installed the INIT/Control Panel combo, you will be forced to restart
your system. If you didn’t install the combo, you will be returned to the
Finder.

When you return to Finder (either by rebooting or by quitting the
installer), take note of the file named ‘Read.Me.Now’. This is a ‘Teach’
document that contains information regarding the latest release of the
SoundMeister and its accompanying software. Double click it and the
application ‘Teach’ should be launched, automatically loading the
document. If you never launched a Teach file before, the Finder will tell
you that the application Teach could not be found and will give you an
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option to locate it. You can click ‘Locate’ and navigate through your
online volumes until you find Teach. It is usually located on your system
disk. Once you tell Finder where Teach is, it will never ask you where it
is again.

When viewing the ‘Read.Me.Now’ document, take note of any special
addendums that may be mentioned. You may want to print the file and
keep it with your SoundMeister documentation.

Using The INIT/Control Panel

The INIT portion of this software duo loads at boot time and sets up the
SoundMeister to your predetermined preferences. It then sits in the
background awaiting commands from the Control Panel to change the
SoundMeister’s settings.

The Control Panel is accessed from O Soundieister S|
desktop based applications by i

selectirr:g ‘Control Panels’ from the S I] u n [|M E Is I E r M
‘Apple’ menu (the Apple menu is Noluae: - Input Source:
located under the color apple icon at Mox. ldle i:
the top left of the system menu bar).
Choosing ‘Control Panels’ loads the
Control Panels desk accessory which
gives you access to all control panels
presently installed in the system.
You can choose which control panel
you want to open by scrolling
through the list of icons in the
Control Panels window. Open the
SoundMeister control panel by
finding its icon in the list and double-clicking it. A window appears with
two scroll bars and a pair of radio buttons.

{ @) Line (Stereo, etc.)
1O Hicrophone i

vif

The two scroll bars indicate the maximum amplified volume of the
SoundMeister board and the idle volume. The SoundMeister INIT tries
to be intelligent by tracking an applications use of the built in Digital
Oscillator Chip (DOC). When an application tries to use this chip, the
INIT steps in and sets the SoundMeister volume to the setting indicated
by the maximum volume scroll bar. When an application is done, the
INIT will step in and return the SoundMeister to its idle volume. This
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way the SoundMeister is not busy amplifying hiss when no sounds are
being generated by your computer. While this clever technique works
well in most instances, it is by no means foolproof. This is because some
applications use the DOC in nonstandard ways and thus the INIT has no
idea of what is going on. You will have to experiment to see which of
your sound applications work well with the INIT and which ones don’t.
Of course, you could always set the idle volume equal to the max volume
and thus the SoundMeister amplifier will always be active.

The radio buttons determine whether or not you have a line level or mic
level source connected to your SoundMeister. Typically you will want to
leave this set to line level unless you have a microphone always plugged
into the back of your SoundMeister.

All changes made in the control panel take effect immediately and are
retained even after you shutdown your system. There is no need to
explicitly ‘save’ your changes.

Introduction To DigitalSession™

DigitalSession is a waveform capture/editing application designed to
allow you to record, import, export, change, and enhance sounds on your
Apple Ilgs. It is designed to work in conjunction with your
SoundMeister card as well as other stereo cards that have come before it.
This section provides enough information to get you started with using
DigitalSession. It does not go into detail concerning many of the
advanced features of this program. DigitalSession is pretty intuitive and
straightforward to use, however, if you feel you would like more detailed
information you may purchase the complete DigitalSession manual direct
from Econ at a minimal price.

Installing DigitalSession

The procedure for installing DigitalSession is outlined on page X of this
manual. Once installed, you can copy DigitalSession onto any disk
provided you also copy the ‘Translators’, ‘Filters’ and ‘Effects’ folders
with it.
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Executing DigitalSession

To run DigitalSession, boot your computer into the Finder. Locate the
drive/disk where you installed DigitalSession and open it by double
clicking its icon. Find the DigitalSession folder and open it, again by
double clicking the icon. You will then see a little waveform icon titled
DigitalSession. This is the application icon. You can execute it by
double clicking it in the window. You can also drag the icon to the
Finder desktop and close all the windows you opened. This keeps
DigitalSession instantly accessible every time you start your computer
into the Finder.

DigitalSession Menus

When you launch DigitalSession, a menubar appears at the top of the
screen with the following menus: File, Edit, Input, Output, Filters and
Effects.

The File Menu

The File menu contains commands that let you load, save, import and
export sound files to/from DigitalSession.

New - Select this to create a new waveform

from scratch. This implies you will be
New N recording the waveform or pasting one in
Open a0 from the clipboard.
Save és . . .
Save 05... Open - Opens a native DigitalSession
Close ol waveform from disk.
Taport Wavefora... Save - Saves the waveform to disk in native
Import rSoundSample.. DigitalSession format.
Export Waveform...
Export rSoundSoaple... Save As - Saves the file to another name.
Quit 8] Import Waveform - Imports a waveform
from another file format such as
HyperStudio™,

Import rSoundSample - Imports a sampled sound resource from any
application which uses rSoundSamples. This include HyperCard Ilgs
and the Sound control panel.
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Export Waveform - Exports a waveform to a foreign file format for use
by other applications.

Export rSoundSample - Creates an rSoundSample resource and
attaches it to the specified file.

Quit - Quits DigitalSession

The Edit Menu

The Edit menu provides commands that are useful for editing an open
waveform. This includes full access to the clipboard for cut and paste
operations on selected sections of a wave. A fully functional Undo also
allows you undo any mistakes or changes you make to the waveform.

Undo - Removes the last change you made to
the wave form. Thus if you delete a range and

Unde a2 decide you didn’t want to do that, just select
Undo and the waveform will return to its state

Cut ol before the deletion.

Copy at

Paste ay Cut - Removes the selected range from the

Cleor wave and places a copy of it in the clipboard.

Select A1l A Copy - Copies the selected portion of the

Deselect db| wave to the clipboard.

Preferences... Paste - Pastes a copy of the clipboard into the

waveform. If a range is selected then it will
be replaced, otherwise the copy will be
inserted at the insertion point.

Clear - Removes the selected range from the waveform. No copy is
made.

Select All - Selects the entire waveform allowing you to perform some
processing on it.

Deselect - Deselects the current range, placing the insertion point at the
beginning of what was the range.
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Preferences - Allows you to edit the various environment attributes
which controls how DigitalSession performs its functions.

The Input Menu

This menu contains commands that allow you to input data into the file,
be it recorded sounds or synthesized waveforms.

Record - Opens the digitizing recorder.
Use this to record either a line level or mic
level sound with your SoundMeister card.

Record... ok

Record Settings... Record Settings - Allows you to change
various settings regarding the digital

Generate Tone... 4T recorder. This includes the type of
hardware you are using, the input signal

Dscilloscope... level (line or mic) and the input sensitivity.

Generate Tone - Generates a pure Sine,
Square or Triangle waveform and inserts it
into the file.

Oscilloscope - Allows you to monitor your input source. This is useful
to see if your are dealing with a weak source or a strong source allowing
you to adjust the sensitivity accordingly. It also is useful in adjusting the
zero point of your samples, which should be falling right on the midpoint
of the scale.

The Output Menu

The commands in this menu control the playback of the waveform
presently being edited.

Play Selection - Plays only the portion of
the waveform that is presently selected.
Good for isolating what portion of a wave
you wish to edit.

Filters Effe
Play Selection

PlayWaveform 6P
Halt bensrotars 4K

Play Waveform - Plays the entire
waveform.

Imaging... ]|
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Halt Generators - Stops any sound that is presently playing. This is
useful if you started playing an extremely huge sound and don’t want to
listen to it through completion.

Imaging - Allows you to control the stereo imaging and volume of the
waveform. It also allows you to control exactly how the DOC will be
used to generate the sound.

The Filters Menu

This menu contains all the filters that are presently installed in
DigitalSession. Filters are user programmable so it is quite likely that
third party filters will be coming available. Filters are applied to what-
ever portion of a waveform that you have selected.

By definition, a filter is supposed to take the original data, enhance it in
some way and replace it in the waveform without affecting the size of the
waveform. This is typically used for noise reduction or frequency
isolation.

The Effects Menu

This menu contains all the effects that are presently installed in
DigitalSession. Effects are user programmable so it is quite likely that
third party effects will be coming available. Effects are applied to
whatever portion of a waveform that you have selected.

By definition, an effect is supposed to take the original data, apply some
special processing to change the sound in some way, and replace it in the
waveform. This may or may not affect the size of the waveform.
Examples of effects are applying an echo to a sound or bending the pitch
of a sound.

The Waveform Editor

When a wave is created or opened, it is displayed in a waveform editor
window. This window allows you to select portions of the wave for
editing, change the playback frequency of the wave, or magnify the wave
to the point that each pixel represents a single sample.
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Selecting A Range

To perform some editing function on a portion of a wave, you need to
select that portion before editing can occur. Selecting a portion of a
wave can be compared lo selecting a portion of text in a word processor.
You begin by clicking the mouse at the start of the portion you wish to
select. Continue holding the mouse button down while dragging the
pointer so that the range you desire becomes selected. Notice that the
background of the wave becomes black and the wave data itself turns
white. The black background indicates the portion of the wave that has
been selected.

Once you select a portion of a wave you can perform cut/copy/paste
operations or apply one of the many filters and effects that DigitalSession
has to offer.

Inserting Data Into A Waveform

To insert data into a wave, you must first specify the point at which !
insertion is to occur. Simply position the mouse around the point you

want to insert at and click the mouse button once. You will notice a

vertical red bar is drawn at the point where you clicked. This is the wave

insertion cursor, and is similar to a cursor in a word processor. You can

fine tune its position by using the arrow keys. You can even delete

samples to the left of the cursor by pressing the DELETE key. The exact

point in the wave where the cursor is located is displayed at the top of the

editor window. All the numbers are in seconds and represent a displace-
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ment into the wave.

After you choose the desired insertion point any paste or record opera-
tions will insert the new data after the insertion cursor. The displacement
of the cursor itself will not change, but the overall length of the wave will
certainly get larger.

Changing The Playback Rate

At the upper left comer of a the wave editor window there is a number
displayed in Kilohertz (kHz). This represents the number of samples that
are played back per second. A number of 11.0 kHz indicates that this
wave will be played back at 11,000 samples per second. Increasing this
number makes the sound’s pitch higher while lowering this number
makes the pitch lower. To change the playback rate, click either the up
or down arrow buttons displayed next to the current sample rate.

Note that when making a recording, the digital recorder will sample data
at whatever rate is presently specified for the waveform. Higher numbers
yield better sounding results but occupy much more space in RAM or
when saved to disk.

Making An Original Recording

To record a sound with DigitalSession, you start by selecting ‘New’ from
the ‘File’ menu. This creates a new, blank waveform for you to start
with. Notice that when a waveform is opened or created, the insertion
point is automatically placed at the beginning of the file. This indicates
that our recorded data will be placed at the beginning of this waveform,
which is what you want.

The first thing you must do is decide what frequency you wish to record
at. By default, waves are created with a playback frequency of 11.0 kHz.
This will yield pretty good results. As mentioned previously, higher
frequencies will yield better results with the cost of requiring more space
to store the sound. Keep in mind that a 11.0 kHz record generally
comprises of 11K of data for every second recorded, thus 100 seconds
will require one megabyte of storage! If you choose to change your
sampling rate, adjust the frequency at the top of the waveform editor
before making your recording.

When ready to begin recording, chose ‘Record’ from the ‘Input’ menu.
A window appears with a variety of record options. The first thing you
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want to do is make sure your SoundMeister is set properly for the type of
signal you will be recording. To do this click the ‘Settings’ button at the
bottom of the window. Another window will appear showing a variety of
input options. Make sure that either ‘line’ or ‘mic’ level is chosen
depending on what type of signal you are recording. When complete,
click the ‘Done’ button. This returns you to the digital recorder window.

In the digital recorder window you can choose from a variety of options
that help make recordings easier:

Record Haveform

Record Hode: Mona
Sompling Rate: 11.00 kHz
Max. Rec. Time: 214.24 seconds
Constraint: @ None (O Limit to:[[ITH_Jseconds.
Start Threshold: @ None O +/-[0.1 | volts.
Countdown: @00 QO 0ff

Catngs.) (ol ((Reewrd )

The constraint option allows you to tell DigitalSession to record for only
a predetermined period of time, say 15 seconds. This is useful if you
need to record for fixed period of time such as for a TV or Radio

commercial. If the recording stops before you are done talking then you
know you must talk faster!

The Start Threshold tells the recorder to wait until it actually receives an
input signal before it begins recording. This eliminates any ‘dead air’
from the beginning of your waveform.

The Countdown feature will present you with a countdown from five
before DigitalSession begins recording. This allows you to time yourself
to coincide with the beginning of the recording.
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Record Settings
Hardware:| SoundMeister  wj

Signal: O lLineLevel @ Mic Level
Local Monitor: @ 8n L

Record Node; 1”3 Steren @ Nono
(O Mux. Stereo

Sensitivity: O Stondard O High
@ Nedive

When you are actually ready to begin recording, click the ‘Record’
button. If you are using a microphone speak loudly and clearly. If your
are recording a line level source such as a CD player, begin playing from
your source. The recording session will continue until 1) you press a key
on the keyboard, 2) the specified time constraint elapses, or 3) the
recording takes up every last bit of available memory.

Playing A Waveform

Whenever a waveform is loaded into an editor window, you can play it in
its entirety by choosing ‘Play Waveform' from the ‘Output’ menu. If
you have selected only a portion of a wave, you can play just that portion
by choosing ‘Play Selection’ from the ‘Output’ menu.

Turning A Mono Wave Into A Stereo Wave

Whenever you are editing a mono (single channel) wave, you can convert
it into stereo by clicking the zoom box control at the upper left title bar of
the active editor window. The editor window will then double in size
showing both channels of the wave. Furthermore, playback will now be
performed on both output channels of the SoundMeister card.



